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Microsoft Word Associate 
Enter Dates  

Instructor Information 

Instructor  Email  Office Location & Hours  
add text add text  add text 

General Information  

Description 
Master the full range of Microsoft Word skills with this comprehensive course, designed to prepare you for 
the Microsoft Office Specialist: Word Associate Certification (MO-110). This coursebook provides the essential 
knowledge and hands-on experience needed to navigate Word’s interface, format documents, manage text, 
insert tables and graphics, and collaborate efficiently, which are key skills for professionals, students, and 
anyone looking to create polished, professional documents. 

Whether you're drafting business reports, academic papers, or professional correspondence, this course 
offers step-by-step instruction to help you develop proficiency in document organization, page layout, 
SmartArt, and collaboration tools while ensuring you can work effectively within Microsoft 365 Apps. 

Course Objectives 
This coursebook teaches the skills you will need to successfully complete the Microsoft Office Specialist 
certification offered by Certiport. These skill sets are introduced using multiple types of exercises and review 
materials. 

After completing this course, you will understand the following:  

 Navigate & Customize the Word Interface: Understand the Ribbon, Backstage View, Quick Access 
Toolbar, and ScreenTips to enhance efficiency. 

 Create & Manage Documents: Open, save, and edit documents, including working with templates 
and converting PDFs into Word files. 

 Text Editing & Formatting: Use Find and Replace, Undo/Redo, Cut, Copy, Paste, Font styles, Character 
Spacing, Drop Caps, and Special Effects for precise text management. 

 Page Layout & Structure: Adjust margins, page orientation, columns, section breaks, headers, footers, 
and watermarks to improve document readability. 

 Tables & Lists: Insert and format tables, bulleted and numbered lists, multilevel lists, and custom 
numbering for organized content presentation. 

 Graphics & Visual Enhancements: Work with images, SmartArt, charts, 3D models, icons, and 
WordArt to create visually engaging documents. 

 Collaboration & Review Features: Track changes, manage comments, review spelling and grammar, 
and apply document protection settings. 

 Automatic Formatting & References: Utilize Table of Contents, footnotes, endnotes, bookmarks, 
cross-references, and citation tools for well-structured documents. 
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By completing this course, you will be fully prepared to earn the Microsoft Office Specialist: Word Associate 
Certification (MO-110) and demonstrate your expertise in document management, advanced formatting, and 
collaboration tools. This coursebook provides everything you need to succeed in Microsoft Word, regardless 
of whether you’re validating your skills for career advancement or refining your proficiency. 

Expectations and Goals  
Upon completion of this course, learners are expected to complete the Microsoft Office Specialist exams. 
Candidates for this exam should have a foundational knowledge of word processing fundamentals and how 
those services are provided with Microsoft Word. The exam is intended for candidates who are just beginning 
to work with word processing software or are new to Microsoft Word. To learn more about the Microsoft 
Office Specialist program visit: Microsoft Office Specialist :: Certiport (pearsonvue.com) 

Certifications provide significant advantages to professional and job candidates. These include: 

• Higher grade point average for certified high school students 

• Higher graduation rates for certified high school students 

• Increased post-secondary enrollment 

• Reduced dropout rates 

Additional information: The value of certification 

Course Materials  

Required materials  
 XperienceED account 

 Computing Device 

 Internet Connection 

Optional materials  
 Headset 

Schedule  

Dates Unit  

 Unit 1: Getting Started 

 Unit 2: Working with Text 

 Unit 3: Formatting Documents 

 Unit 4: Organizing Text 

 Unit 5: Working with Graphics 

 Unit 6: Working with Documents 
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Course Structure 

The course is structured to learn by doing, practice the learned skill, then apply the skills. 

• Unit 
• Lesson 

 Learn Tasks 
 Practice Exercises 
 Practice Questions 

• Objective Assessment 
• Create Project 

Each unit contains lessons. The lessons are introduced by lesson topics where you can learn through doing 
or learn through study materials (eBook, QuickDeck or QuickClip). Each lesson concludes with a Practice 
Exercise that incorporates the tasks you have learned throughout the lesson. Once you have completed the 
lessons in the unit, you are assessed through a question-based Objective Assessment and a Create Project. 

Weights and Grading 

Add your course weight and grading here 

 

Additional information and resources  

Add a subheading  
Add text. 
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Instructor Guide Overview 
Course Structure 
The course is structured to learn by doing, practice the learned skill, and then apply the skill. 

• Unit 

o Lesson 

 Learn Tasks 

 Practice Exercises 

 Practice Questions 

o Objective Assessment 

o Create Project 

Each unit contains lessons. The lessons are introduced by lesson topics where learners can 
understand through doing or learning through study materials. Each lesson concludes with a 
Practice Exercise that incorporates the tasks they learned throughout the lesson. Once they have 
completed the lessons in the unit, learners are assessed through a question-based Objective 
Assessment and a Create Project. 

Delivery 
The course is created so it can be customized to meet the needs of the instructor and the learner.  

• Direct Instruction:  Utilize the PowerPoint presentations to introduce each lesson topic, 
then have the learners review the study materials and complete the task. 

• Flipped  Classroom:  Learners complete lessons outside of class time. Learners utilize the 
class time to discuss learned tasks, allow learners to teach concepts, expand concepts 
through learning stations, and work on unit extension or unplugged activities. 

Differentiation 
• Applied Learning Resources: Applied exercises outline what learners need to complete. 

Learners study the concept and then apply that knowledge to complete the Learn Task. 
These exercises reinforce independent problem-solving and help learners demonstrate 
mastery. 

• Guided Learning Resources: Guided learning resources provide step-by-step instructions 
to support learners in completing the Learn Task. These resources scaffold the process, 
ensuring that learners can successfully practice and build confidence as they progress 
through the content. 
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• Extension Activities: Encourage learners to showcase their newly learned skills by creating 
additional real-world projects, teaching others how and why to use new skills, and exploring 
beyond their learning. 

Prepare for Delivery 
• Begin with the unit overview to understand the structure and flow of the unit, the topics 

covered, the approximate time to complete and the exam objectives reviewed. 

• Review the lesson PowerPoint Presentation to give you an in-depth look at each lesson 
topic and the comprehensive topic notes included. 

• Review the answer keys to familiarize yourself with the tasks learners will complete 
throughout the lesson. 

• Complete the lesson. 

Instructor Resources Overview 
Instructor 
Resources 
File Structure 

 Instructor Resources  
 Course Syllabus 
 Course Overview 
 Course Key Terms 
 Course Instructor Guide 
 Unit 

 Unit Assessment Answer Keys 
 Create Project 
 Objective Assessment  

 Lesson 
 Answer Keys 

 Lesson Practice Exercises 
 Learn Tasks 
 Lesson Practice Questions 

 Study Guides 
 Study Guide Complete 
 Study Guide Fill-In Explanation 
 Study Guide Fill-In Topic 

 Lesson PowerPoint Presentations 
 Unplugged Activities 
 Unit Overview 
 Unit Learning Plan 
 Unit Key Terms 

 Learner Resources 
Unit Assessment 
Answer Keys 

Each unit includes two types of assessments for learners to apply their 
knowledge. 

• Create Project – These are project prompts and sample solution 
files.  
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• Objective Assessment – A comprehensive question and answer-
based assessment for the unit.  

Answer Keys 
 

Documents containing answers, step-by-step instructions, and correct 
answers for Instructor reference or to offer additional support material for 
learners. 

• Learn Tasks - Each lesson topic includes an opportunity to apply 
what they have just learned or by answering questions.  

• Lesson Practice Exercises – End of lesson exercises or scenario-
based assessment.  

• Lesson Practice Questions – End of lesson question-based 
assessment.  

Study Guides Printable and customizable study guides mapped to lesson topics and 
exam objectives are provided in three formats. 

• Complete- This version includes the topic and the explanation. 
• Fill-In Topic-Learners can fill in the topics as they learn or as a 

review. 
• Fill-In Explanation – This allows learners to complete the 

explanation of each lesson topic in their own words and images. 
Learning Plan Customizable unit learning plan outlining the objectives and topics 

covered, essential questions, learning targets, methods and materials, 
extension activities, formative and summative assessments, mapping to 
STEAM, Work Readiness, 5 C’s, and Bloom’s Taxonomy Levels.  

Lesson 
PowerPoint 

A PowerPoint Presentation that complements the lesson. Each lesson topic 
is included in the presentation as well as comprehensive speaker notes. 

Unplugged 
Activities 

A variety of activities and necessary resources to get learners off the 
computers while still reinforcing unit learning objectives. 

Unit Key Terms A comprehensive list of key terms throughout the unit. 
Unit Overview A spreadsheet containing the overview of the flow of the unit that includes 

lesson topics, certification objectives mapping, and approximate timings for 
self-paced and instructor-led scenarios. 

Learner 
Resources 

Printable learner resources are available to support both applied and guided 
learning.  

• Applied Learning Resources – Printable prompts that direct 
learners to study the concept before applying their knowledge to 
complete the Learn Task. 

• Guided Learning Resources – Step-by-step printable guides that 
lead learners through the process of completing the Learn Task, 
providing structure and support as they build skills. 
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Word Learning Plan 

Unit 1: Getting Started  
Instructor: Class: Duration: 6-11 hours 
Unit Objectives:  
This unit focuses on developing the skills required to proficiently utilize advanced commands and features in 
document processing software. Learners will gain a deep understanding of document settings and formatting 
options, and they will learn to efficiently manage and collaborate on documents for various professional and 
academic purposes, thereby demonstrating their mastery in working with documents. 
Essential Questions:  
• How can an understanding of Microsoft Word, its interface, and the various commands and features 

enhance document creation and productivity?? 
• How can creating new documents, utilizing document templates, and managing file types, empower you 

to efficiently produce, share, and customize documents for various purposes? 
• How can an understanding of Microsoft Word's core functionalities and document settings empower 

individuals to create professional and organized documents efficiently? 

Learning Targets: 
I will understand the Word interface and ribbons 
So I can create new documents 
I know I succeeded when I can adjust document settings according to my needs. 
Methods and Materials: 

• Lectures 
• Reading 
• Videos 
• Hand-on activities 
• Creating 
• Analyzing  
• Discussing 
• Teaching 

Formative Assessments: 
• Learn Tasks 
• Practice Questions 
• Practice Exercises 

Summative Assessments: 
• Objective Assessment 
• Create Project 

STEAM 
☐ Science 
☒ Technology 
☒ Engineering 
☒ Art 
☐ Math 

Work Readiness 
☒ Communication 
☒ Problem-solving 
☒ Teamwork 
☒ Work ethic 
☒ Empathy 
☒ Conflict resolution 
☒ Active listening 
☒ Time management 
☒ Adaptability 
☒ Reading 
☒ Mathematics 

5 C’s 
☒ Critical Thinking 
☒ Creativity 
☒ Communication 
☒ Collaboration 
☒ Citizenship 

Blooms Level 
☒ Remembering 
☒ Understanding 
☒ Applying  
☒ Analyzing 
☒ Evaluating  
☒ Creating 
 

 

8



Learning Activities 
Lesson Time Allowed Content 

Commands and 
Features 

65-145 minutes • What is Microsoft Word? 
• Microsoft Word Interface 
• Backstage  
• ScreenTips 
• Quick Access Toolbar 
• Ribbon 
• Ribbon Tabs 
• Understand Ribbon Tabs 

Work with Documents 65-145 minutes • New Documents 
• Document Templates 
• Open Documents 
• Save Documents 
• Save PDFs 
• Convert PDFs to Word Documents 
• Word File Types 
• Identify Extensions 

Document Settings 65-145 minutes • Review Document Statistics 
• Document Properties 
• Inspect Document 
• Check Accessibility 
• Check Compatibility 
• Print Preview 
• Set Print Parameters 
• Share Documents 

Document Views 65-145 minutes • Change the View 
• Manage Views 
• Manage Outline View 
• Zoom 
• Split the Window 
• Show/Hide ¶ 
• Ruler 
• Gridlines 

 

Warm-Up Activities 
1. Take a moment to think about your experience using Microsoft Word. List at least three features or 

functions that you have used in the past. Consider formatting tools, editing options, or any other aspects of 
Word that you are familiar with. 

2. Explore different types of documents you've encountered or heard of that you might use Microsoft Word 
for. Select one and briefly describe what type of document it is and why you might need to create it. 

Extension Activities 
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1. Create a portfolio for the course. Portfolios should include evidence of work, reflect on learned skills and 
how you can incorporate the skills in a current or future project. This is an ongoing extension activity. 
Continue to add to the portfolio throughout the course. 

2. Select one topic learned throughout the unit, then create an instructional video, tutorial, lecture, or hands-
on activity to teach others about the skill. 

3. Imagine you're a marketing manager at a middle-sized company, and you've got an important job to do. 
Your team is making a big report that talks about how the company plans to do its advertising for the next 
few months. This report is going to be shown to the big bosses at your company, the people who have an 
interest in your company's success, and folks who might invest money in your company. As the time when 
everything needs to be finished gets closer, you'll face some tough situations where what you've learned 
about Microsoft Word will be important. Explain why you may need to use the following document 
statistics, document properties, document protection, and version management. 

 

Unit Evaluation and Reflection 
What went well What needs to change 
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Unit 1 Commands and Features Learn Tasks 
What is Microsoft Word?  

Microsoft Word enables you to create which types of files? (Select all that apply) 

a) Documents (correct) 

b) Reports (correct) 

c) Spreadsheets 

d) Newsletters (correct)  

e) Spreadsheets 

   
Microsoft Word Interface  

In the Microsoft Word window image identify the following: 

1) File Tab  

2) Quick Access Toolbar 

3) Ribbon Tabs  

4) Title Bar  

5) Search Field 

6) Minimize/Maximize/Restore Down/Close  

7) Status Bar  

8) View Buttons  

9) Zoom Slider  

10) Zoom Level  

 

  

 
Backstage  

Practice identifying features in the Microsoft Word window. 

1) Open Backstage.docx 

2) View the document info in the Backstage view 

• File tab > Backstage view > Info 

3) Create a new document 

• New 

4) Open an existing file  

• Open 
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5) Save the file  

• Save 

6) Return to the document  

• Back  

7) Save to your course files 

 

 

ScreenTips  

1) Use ScreenTips to: 

a) View the backstage 

b) Change document views 

c) Help identify buttons (correct) 

d) Access frequently used commands 

 

2) This image is a screen tip for _____? 

 
a) Modifying the ribbon options 

b) Modifying the QAT (correct) 

c) Modifying the paragraph option 

 
Quick Access Toolbar  

In the Microsoft Word window select the Quick Access Toolbar. 

1) Open Quick Access Toolbar.docx 
 

2) Select the Quick Access Toolbar 

• Quick Access Toolbar 
  

3) Save to your course files 

  

 
Ribbon  

Alternate between Ribbon settings in the Microsoft Word window. 

1) Open Ribbon.docx 
 

2) Select the Ribbon 

• Ribbon  

3) Auto-hide the Ribbon 
• Ribbon Display Options drop-down arrow > Auto-hide Ribbon  
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4) Set the Ribbon to only show tabs 

• Ribbon Display Options drop-down arrow > Show Tabs  
5) Set the Ribbon to show tabs and commands 

• Ribbon Display Options drop-down arrow > Show Tabs and Commands  
6) Save to your course files 

 
1) Open Ribbon.docx 

2) Select the Ribbon 

• Ribbon  

3) Set the Ribbon to Show Tabs 

• Ribbon Display Options drop-down arrow > Show tabs only 

4) Set the Ribbon to only show only when the cursor is moved over it 

• Ribbon Display Options drop-down arrow > Adjust automatically 

 

Ribbon Tabs 

Find elements related to the Ribbon tabs in the Microsoft Word window. 

1) Open Ribbon Tabs.docx 

2) Display the Insert tab 

• Insert tab  

3) Select the Illustrations group 

• Illustrations group 

4) Display the Design tab 

• Design tab 

5) Select the Style gallery 

• Home tab > Styles group > Style gallery 

6) Display the Home tab 

• Home tab 

7) Display the Font Dialog Box Launcher 

• Home tab > Font group > Font dialog box launcher  

8) Select the contextual tab   

• Header and Footer context tab 

9) Save to your course files 
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Understand Ribbon Tabs  

1) Match the words to their correct descriptions. 

a) Home 

b) Insert 

c) Draw 

d) Design 

e) Layout 

The Home (correct) tab provides several frequently used editing features, such as copy and 
paste, text formatting with bold, various fonts, alignment, a style, etc. 

The Insert (correct) tab allows the user to add extra elements to the document, such as 
tables, icons, shapes, pages, symbols, etc. 

The Draw (correct) tab enables the user to use a pen tool. 

The Design (correct) tab provides various formatting options for your document such as 
themes, effects, color schemes, paragraph spacing, etc. 

The Layout (correct) tab allows the user to modify the document, including the page 
orientation, margins, page breaks, spacing, etc. 

 

2) Match the words to their correct descriptions. 

a) References 

b) Mailings 

c) Help 

d) Review 

e) View 

The References (correct) tab enables the user to enter document sources and citations, build 
a table of contents, add footnotes and endnotes, create an index, etc. 

The Mailings (correct) tab, which is the least used, allows users to merge emails, write, insert, 
and merge different fields, etc. 

The View (correct) tab enables users to check grammar, proofread, check accessibility, track 
changes, add or remove comments, etc. 

The View (correct) tab allows users to shift between different views of the document, change 
page movement, switch windows and has the feature of the Immersive Reader. 

The Help (correct) tab provides you with necessary features such as contacting Microsoft 
Support, providing feedback to Microsoft, viewing training videos and learning about new 
tools. 

 

3) This ribbon is hidden by default and includes many tools that can help increase productivity 
when working with documents, such as macros, installing add-ins, using content controls to 
build online forms, protect against people making changes, or manage templates. 

a) Review tab 

b) View tab 

c) Mailing tab 

d) Developer tab (correct) 
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Unit 1 Commands and Features  
Practice Exercise 
 

Identify the correct Ribbon tab for each function listed. 

1) Open U1 L1 Practice Exercise.docx 

2) Locate the Ribbon tab that provides various formatting options for your document such as 
themes, effects, color schemes, and paragraph spacing 

• Design tab 

3) Locate the Ribbon tab that enables users to check grammar, proofread, check accessibility, 
track changes, and add or remove comments 

• Review tab 

4) Locate the Ribbon tab that provides several frequently used editing features such as 
copy/paste, text formatting with bold, various fonts, alignment, and styles 

• Home tab 

5) Save to your course files 
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Unit 1 Commands and Features  
Practice Questions 
 
1) Which type of document can you create using Microsoft Word? (Choose all that apply) 

a) Agendas (correct) 
b) Budgets 
c) Catalog (correct) 
d) Invoice (correct) 
e) Slide show 

 
2) Fill in the blanks with the correct words.   

Choose commands that manage the document with the File tab (correct), whereas commonly 
used commands can be found on the Quick Access Toolbar (correct).  
To activate the Zoom dialog box to enter a view percentage, select the Zoom Level (correct) 
option. To see the total number of pages in the document, use the Status Bar (correct) option. 
 
• File tab 
• Quick Access Toolbar 
• Zoom Level 
• Status Bar 

 
3) Which view is available for all Office programs, giving you a central location to manage files? 

a) Backstage (correct) 
b) Outline 
c) Normal  
d) Draft 
e) Save As 

 
4) ScreenTips always appear when you point at anything on the screen and always show a 

keyboard shortcut you can use. 

• True 
• False (correct) 

 
5) Which buttons are seen on the Quick Access Toolbar by default? (Choose all that apply) 

a) Save (correct) 
b) Redo (correct) 
c) New 
d) Open 

 
6) The Quick Access Toolbar can only be located at the top left of the application screen. 

• True 
• False (correct) 
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7) Match the correct term to the description. 

a) Active Ribbon tab 
b) Group 
c) Dialog box launcher 

 
Active Ribbon tab (correct) Always displays with different background color or has an outline. 
Group (correct) A set of related commands that perform similar tasks, such as cut, copy and 
paste. 
Dialog box launcher (correct)  Launches a dialog box or pane with more options for the 
group of commands. 
 

8) Which of the following Ribbon tabs allows you to draw and create tables for small or large 
amounts of data? 

a) Draw 
b) Design 
c) Insert (correct) 
d) Layout 

 
9) A Ribbon tab can be hidden by going into the Word options and in the Customize Ribbon 

option, turn off the checkbox for the Ribbon tab. 

• True (correct) 
• False 
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Unit 1 Create Project 
The Create project is designed to allow the application and demonstration of new knowledge, skills, 
and personal creativity to produce a project-based result while integrating rubric requirements 
using a checklist. 

Tip: While working on your project, remember to save your progress regularly. This will allow you 
to come back to it later. To continue working, open the document, then launch the platform using 
the Add-in whenever you're ready. 

Begin your project by: 

1. Create a new document using a brochure or flyer template 
2. Save the document on your computer 
3. If needed, open the document 
4. Launch XED 

Choose from one of the projects below:  

• Create a Personal Biography: Use a Word template to write a short personal biography 
about yourself. Include your name, background, interests, and a fun fact about you. 

• Design a Simple Event Flyer: Create a flyer for a school event, club meeting, or family 
gathering using a Word template. Add a title, date, time, location, and a short description of 
the event. 

• Write a Short Letter: Create a short letter to a friend, family member, or fictional character. 
Use proper letter formatting, paragraph spacing, and an appropriate closing. 

• Your Own Project Proposal: Propose a project idea of your choice to your instructor for 
approval. The goal is to develop a creative and feasible project idea that aligns with the 
course objectives and your interests. 

Complete a document using the following as a guide/checklist. 

� Use the gridlines and rulers to align images and text 
� Use the Show/Hide to remove unneeded breaks 
� Change the view of the document to ensure you have the desired design 
� Update the document properties to include a document title and your name as the author 
� Inspect the document to ensure there is no hidden text or comments 
� Check the document’s accessibility and resolve any issues 
� Save the document as a PDF 
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Unit 1 Objective Assessment 
 
1) You have been tasked with creating an article to be published in an online monthly 

newsletter. The article needs to have no more than 500 words and at least two photos. They 
have also asked if you can provide a ready-to-publish professional document. Which software 
program would you use to create this article? 

a) Microsoft Word (correct) 
b) Microsoft Publisher 
c) Microsoft PowerPoint 
d) Adobe InDesign 

 
2) A friend has asked you to help them identify some basic terms on the Word Interface so they 

can understand the screen. Match the correct term to the description.  

a) Quick Access Toolbar 
b) Title Bar 
c) Tell Me 
d) Status Bar 
 
Quick Access Toolbar (correct) Frequently used buttons on a toolbar   
Title bar (correct) March Sales Figures report name   
Tell me (correct) On screen help field                      
Status Bar (correct) Spelling error icon location        

 
3) A simple purpose for Backstage is that options in this view are related to things you can do 

with the entire file itself. 

• True (correct) 
• False 

 
4) To help a friend who is struggling with learning the new features of Word, which option would 

you direct them to read and reinforce skills on the screen? 

a) ScreenTips (correct) 
b) Tell Me 
c) File tab 
d) Status Bar 

 
5) Word provides a number of tools you can use to complete tasks. Which of the following tools 

would you use for frequently used actions? 

a) Quick Access Toolbar (correct) 
b) Ribbon Tabs 
c) File Tab 
d) Tell Me 
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6) To demonstrate your understanding of how a Ribbon tab can be set up, review the following 
image and then match the number to the image with its description. 

  
a)  Active Ribbon tab 
b)  Active command 
c)  Dialog box launcher button 
d)  More button for a gallery 
e)  Group of similar commands 

 
1 (correct) Active Ribbon tab 
2 (correct) Active command 
3 (correct) Dialog box launcher button 
4 (correct) More button for a gallery 
5 (correct) Group of similar commands 

 
7) One way to learn where commands can be found is to associate them with specific types of 

tasks. Review the following descriptions and then match the words to the Ribbon tab name 
that best suits the description. 

a) Home 
b) Insert 
c) Review 
d) References 
e) Layout 
f) Design  
 
Home (correct) Commonly used commands such as copy and paste. 
Insert (correct) Insert anything other than text. 
Review (correct) Check and proof the document before distributing 
References (correct) Insert research sources or links for a report. 
Layout (correct) Set up options for how the page will appear.      
Design (correct) Apply elements to change the page’s overall appearance. 

 
8) When you launch Word, the Backstage view appears. What can you do next? (Select all that 

apply) 

a) Create a new blank file (correct) 
b) Open an existing file (correct) 
c) Save an existing file 
d) Save a new blank file 
e) Print the new blank file 

 
9) Many people use the PDF format to share files. Identify which of the following options are 

benefits of using the PDF format. (Select all that apply) 

a) Maintains the design layout and format for distribution. (correct) 
b) Restricts others from editing the file. (correct) 
c) Makes the file smaller to use as a link for downloading. (correct) 
d) PDF files can be read in any program for easy reviewing. 
e) PDF files are always saved as read-only. 

20



10) You receive a PDF file of the inventory list at the warehouse. The inventory items appear to 
have been set up as columns. Why might you want to convert this file into a Word document 
versus an Excel spreadsheet file? 

a) The PDF can be opened and converted directly within Word. (correct) 
b) You need to convert the PDF file to a text file before you can open it in Excel. 
c) Word will automatically convert the file into a table format. 
d) Excel will convert the file into a database format. 

 
11) Fill in the blanks with the correct words. 

Word automatically assigns a .docx (correct) extension to the end of the file name. If you need 
the file to open in a previous version, you should save the file using .doc (correct) extension. 
The .doc (correct) extension can also be opened by other word processing programs without 
needing any formatting edits. The easiest file format to open in an application with the .txt 
(correct) extension but it does not include any formatting. 
 
• .docx 
• .doc 
• .doc 
• .txt 
 

12) It is important to check for any accessibility issues before you share documents with others on 
a global basis. This is crucial when posting online documents with audio or visual elements. 
How does Alt text help with addressing the accessibility issues? (Select all that apply) 

a) Alt Text provides a description for an object that cannot be identified with a text 
reader. (correct) 

b) Alt Text checks to ensure the text is valid for any translation of the document text. 
c) Alt Text checks that a list of figures is available for all images or objects in the document. 
d) Alt Text is saved with an image file so this file can be used in any online document.  

 
13) Knowing that objects in documents are compatible with higher versions of Word, why is it 

important you run the Compatibility Checker before sharing a Word 2019 document with a 
friend who has Word 2007 installed? 

a)  Some objects such as SmartArt diagrams are not compatible with previous versions of 
Word. (correct) 

b) Running the Compatibility Checker tells you how much the file will be reduced in size to 
match Word 2007 requirements. 

c) Computing devices with Word 2007 generally do have enough RAM memory installed to 
show a document with lots of pictures. 

d) This is not a concern as newer versions of Windows address compatibility issues. 
 

14) Fill in the blanks with the correct words.  

When you save documents to a cloud (correct) location, you will see different versions 
(correct) of the file appear in a list. 
This can be helpful if you collaborate (correct) with others on the same file and you want to 
review (correct) the changes made to the file yesterday. 
 
• collaborate 
• versions 
• cloud 
• review 
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15) You can preview your document at any time to view how it will print. In this view, you can 
adjust the size of the page(s) in the document. Review the following image and then select 
the number for the feature that enables you to zoom into a single page. 

 
a) 1 
b) 2 
c) 3 
d) 4 (correct)  

 
16) Just as you are ready to print the final version of the promotional sheet, a friend tells you some 

last minute changes are needed. This includes customizing the margins, changing the 
orientation, and possibly adding columns to the bottom portion of the document. Which 
option would you use to make these changes? 

a)  Print parameters in the Preview view of Backstage 
b) Select Page Setup in the print parameters and made changes using the options in the 

Layout tab (correct) 
 

17) You have been working on an agenda for next month’s staff meeting. Now that you are done, 
you need to share it with your friends. Which is the best method to share the file? (select all 
that apply) 

a) Send the file via email to everyone. (correct) 
b) Save it to your OneDrive Personal location. 
c) Send an invite to your friends with a link to the online file (correct) 
d) Save the file to a central Teams location. 

 
18) You are working on a project at home and currently do not have access to your files on the 

school network (Internet is active but the school network is down for maintenance). Which is 
the best option to send the work you’ve done on the project to your team members? 

a) Send the file via email as an attachment. (correct) 
b) Save the file to USB that can be shared between your team members. 
c) Go to the public library where you can send the file to the school network. 
d) Ask the team to come to your home to get a printout. 
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19) There are a number of ways you can change the view of the document contents. Review the 
following image and select the number that identifies the View buttons. 

 
 

a) 1 
b) 2 
c) 3 (correct) 
d) 4 

 
20) Knowing that you can change the view as required, review the following terms and 

descriptions and match the terms to correctly identify when you would use this view. 

a) Read Mode 
b) Print Layout 
c) Web Layout 
d) Outline 
e) Draft 

 
Read Mode (correct) Read the document as if it were a book. 
Print Layout (correct) Show all items in the document as if this were a printout.  
Web Layout (correct) Show the page as if viewing it on a web browser.  
Outline (correct) Create a table of contents to show the flow of the topics in the document.  
Draft (correct) Focus on entering the text content in the document.  

 
21) Depending on the document, you may need to zoom in or out of areas in a document to see 

more or less detail. Why would using the Zoom Level button to change the zoom be faster to 
return to 100%? 

a) The Zoom dialog box appears where you can then 100% and then OK. (correct) 
b) This button automatically returns to 100% when selected. 
c) You need only to double-click this button to return to 100%. 
d) It automatically returns you to the last percentage used for the zoom. 

 
22) Showing the formatting characters on the screen can be beneficial when editing the text. 

Review the following points and select those which could be included as a benefit. (select all 
that apply) 

a) You can quickly delete extra tab characters that affect the alignment of text. (correct) 
b) You can quickly identify if there are extra blank lines you don’t need in the file. 

(correct) 
c) You can identify where the alignment of text was changed. 
d) You can see if you need to add more spacing or images in the document. 
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23) You want to create a diagram that shows the process for a sales strategy and want to display 
gridlines to help align the text boxes. Which Ribbon tab will you find the Gridlines feature? 

a) View (correct) 
b) Insert 
c) Draw 
d) Design 

 

24) There are requirements you need to consider before sharing your files to an online storage 
location such as OneDrive. Review the following items and select the appropriate response for 
each of the items. 

a) Have a Microsoft account. (correct) 
b) Access to a valid OneDrive business or school location. (correct) 
c) Invite others to view or edit the file. (correct) 
d) Must use Edge as the web browser. 
e) File must be 100Kb in size or smaller. 
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Commands and Features
Unit 1: Getting Started
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What is Microsoft Word?

• Word Processor 

• Word enables you to
• Create, modify or publish documents
• Use styles or templates
• Insert illustrations
• Use formatting
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Microsoft Word Interface

From the Startup screen, select a new document 
from multiple options
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Backstage

• Select File tab  to display Backstage view 

• Use Backstage view to 
create, open, save, print, and 
manage files

• Commands and options 
are related to the entire file
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ScreenTips

• Helps identify buttons or elements

• A tip displays the name of the button and a description of 
its purpose
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Quick Access Toolbar

• Contains frequently used commands

• Default settings
• AutoSave indicator
• Save
• Undo
• Repeat/Redo
• Customize Quick Access Toolbar
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Ribbon

• Set of toolbars to find commands to complete a task

• Use   Ribbon Display Options icon to hide ribbon 
automatically, show  tabs  or show tabs and 
commands all the time
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Ribbon Tabs

• Organize command buttons into 
logical groups that relate to a type of 
activity

• Commands separated in related 
groups

• Contextual tabs appear only 
   when available

33



Understand Ribbon Tabs

Ribbon tabs include features to edit font, insert elements, draw 
with a pen, format themes and many more

34



Unit 1 Commands and Features Study Guide 
Complete  

Topic   Explanation   
What is Microsoft Word?  
What is Microsoft Word? Word processing is a method of using a computer to create, edit and 

print documents such as letters, memos, newsletters, or reports. 
Benefits of Word 
Processing 

You can store the documents you create on your computer, giving 
you the option to edit or enhance portions of the entire document at 
any time. 

Word's Features • Use styles or templates. 
• A variety of illustration types. 
• A variety of formatting effects.  

Word's Features • Combine or merge information together. 
• Use tools to assist in creating documents for the Internet. 

Launch Word in Windows • Select the Word tile. 
• Choose All apps > Word. 

Microsoft Word Interface  
File Tab Select this tab to open the Backstage view to manage files. 

Quick Access Toolbar Gain quick access to frequently used commands. 

Ribbon Tabs Select a tab to access commands to complete a specific type of task. 

Title Bar Indicates which file and program is currently displayed in the 
window. 

Tell Me A Help option where you can enter keywords about a particular type 
of task and view information from the Word Help system on how to 
complete that task. 

Minimize/Maximize/Restore 
Down/Close 

Affect how much of the application window displays on the screen. 

Insertion Point The flashing bar on the screen that indicates your current position in 
the document. It is commonly referred to as the cursor. 

Status Bar Find information about the document currently displayed, such as 
which page you are viewing, the total number of pages, or whether 
an error condition exists. 

View Buttons Select to quickly change between the different document views 
available in the application. 

Zoom Slider Select the buttons to zoom in or out in increments of 10% or drag the 
slider button to a specific zoom percentage. 

Zoom Level Select this button to display a window for various percentages to 
zoom in or out of the document, including how to display multiple 
pages. 

Backstage  
Backstage This view is available for all the Office programs, setting a consistent 

look and location for users to use when they want to manage their 
files. 
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Use Backstage View Use to create, open, save, print, and manage your files. 

The Commands and 
Options 

The commands and options available here are related to things you 
can do with the entire file itself. 

In the Backstage You Can Display information about the file, create a new file, open an existing 
file, assign a password, save a file with a different name, or print or 
share the file with others. 

Tabs of the Backstage These tabs are as follows: Home, New, Open, Info, Save, Save As, Print, 
Share, Export, Close, Account, Feedback, and Options. 

ScreenTips  
ScreenTips Identify buttons or elements on the tabs of the Ribbon and the 

screen. 
To View a ScreenTip Position the mouse pointer on the item. 

Quick Access Toolbar 
Quick Access Toolbar Left of the title bar above the Ribbon and contains buttons for 

frequently used commands. 
Ribbon 
The Ribbon Quickly find the commands that you need to complete a task. 

Ribbon Display Options • Show Tabs and Commands 
• Show Tabs 
• Auto-hide Ribbon 

Ribbon Tabs 
Ribbon Tabs Organizes command buttons into logical groups that relate to a type 

of activity, such as inserting objects, designing a page, or reviewing a 
document. 

Groups Each tab contains Ribbon groups with similar commands. For 
example, the Home tab has a group called Font that contains 
commands for formatting text characters. 

Active Commands A command that appears in a different background color or has an 
outline is active. Many of these de-activate when you select the 
button again or select another choice.  

Dialog Box Launcher A group could include a dialog box launcher which will open a dialog 
box containing additional tools and options for the Ribbon group. 

Galleries Galleries will include a scroll bar with a more option that you can 
select to display the full list or gallery for that option. 

Contextual Tabs Tabs appear only when they are applicable. For example, the Header 
& Footer Tools Ribbon tab appears only when you are working with 
headers and footers. 

Understand Ribbon Tabs 
Home Tab Several frequently used editing features, such as copy and paste, text 

formatting with bold, various fonts, alignment, a style etc. 
Insert Tab Insert or add extra elements to the document, such as tables, icons, 

shapes, pages, symbols, etc. 
Draw Tab Draw and erase using different colors and thicknesses with a pen 

tool or trackpad.  
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Design Tab Various formatting options for your document such as themes, 
effects, color schemes, paragraph spacing etc. 

Layout Tab Modify the layout of the document, including the page orientation, 
margins, page breaks, spacing etc. 

References Tab Enter document sources and citations, build a table of contents, add 
footnotes and endnotes, create an index, etc.  

Mailings Tab Merge emails, write, insert, and merge different fields, etc.  

Review Tab Check grammar, proofread, check accessibility, track changes, add or 
remove comments, etc. 

View Tab Shift between different views of the document, change page 
movement, switch windows and has the feature of the Immersive 
Reader. 

Help Tab Contacting Microsoft Support, providing feedback to Microsoft, 
viewing training videos and learning about new tools. 

Developer Tab Macros, installing add-ins, using content controls to build online 
forms, protecting against people making changes, or managing 
templates. You may need to display this Ribbon as it is hidden by 
default. 
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Unit 1 Commands and Features Study Guide 
Fill-In Explanation 

Topic   Explanation   
What is Microsoft Word?  
What is Microsoft Word?  

Benefits of Word 
Processing 

 

Word's Features  

Word's Features  

Launch Word in Windows  

Microsoft Word Interface  
File Tab  

Quick Access Toolbar  

Ribbon Tabs  

Title Bar  

Tell Me  

Minimize/Maximize/Restore 
Down/Close 

 

Insertion Point  

Status Bar  

View Buttons  

Zoom Slider  

Zoom Level  

Backstage  
Backstage  

Use Backstage View  

The Commands and 
Options 

 

In the Backstage You Can  

Tabs of the Backstage  

ScreenTips  
ScreenTips  

To View a ScreenTip  

Quick Access Toolbar 
Quick Access Toolbar  
Ribbon 
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The Ribbon  

Ribbon Display Options  

Ribbon Tabs 
Ribbon Tabs  

Groups  

Active Commands  

Dialog Box Launcher  

Galleries  

Contextual Tabs  

Understand Ribbon Tabs 
Home Tab  

Insert Tab  

Draw Tab  

Design Tab  

Layout Tab  

References Tab  

Mailings Tab  

Review Tab  

View Tab  

Help Tab  

Developer Tab  
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Unit 1 Commands and Features Study Guide 
Fill-In Topic 

Topic   Explanation   
What is Microsoft Word?  
 Word processing is a method of using a computer to create, edit and 

print documents such as letters, memos, newsletters, or reports. 
 You can store the documents you create on your computer, giving 

you the option to edit or enhance portions of the entire document at 
any time. 

 • Use styles or templates. 
• A variety of illustration types. 
• A variety of formatting effects.  

 • Combine or merge information together. 
• Use tools to assist in creating documents for the Internet. 

 • Select the Word tile. 
• Choose All apps > Word. 

Microsoft Word Interface  
 Select this tab to open the Backstage view to manage files. 

 Gain quick access to frequently used commands. 

 Select a tab to access commands to complete a specific type of task. 

 Indicates which file and program is currently displayed in the 
window. 

 A Help option where you can enter keywords about a particular type 
of task and view information from the Word Help system on how to 
complete that task. 

 Affect how much of the application window displays on the screen. 

 The flashing bar on the screen that indicates your current position in 
the document. It is commonly referred to as the cursor. 

 Find information about the document currently displayed, such as 
which page you are viewing, the total number of pages, or whether 
an error condition exists. 

 Select to quickly change between the different document views 
available in the application. 

 Select the buttons to zoom in or out in increments of 10% or drag the 
slider button to a specific zoom percentage. 

 Select this button to display a window for various percentages to 
zoom in or out of the document, including how to display multiple 
pages. 

Backstage  
 This view is available for all the Office programs, setting a consistent 

look and location for users to use when they want to manage their 
files. 
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 Use to create, open, save, print, and manage your files. 

 The commands and options available here are related to things you 
can do with the entire file itself. 

 Display information about the file, create a new file, open an existing 
file, assign a password, save a file with a different name, or print or 
share the file with others. 

 These tabs are as follows: Home, New, Open, Info, Save, Save As, Print, 
Share, Export, Close, Account, Feedback, and Options. 

ScreenTips  
 Identify buttons or elements on the tabs of the Ribbon and the 

screen. 
 Position the mouse pointer on the item. 

Quick Access Toolbar 

 Left of the title bar above the Ribbon and contains buttons for 
frequently used commands. 

Ribbon 
 Quickly find the commands that you need to complete a task. 

 • Show Tabs and Commands 
• Show Tabs 
• Auto-hide Ribbon 

Ribbon Tabs 
 Organizes command buttons into logical groups that relate to a type 

of activity, such as inserting objects, designing a page, or reviewing a 
document. 

 Each tab contains Ribbon groups with similar commands. For 
example, the Home tab has a group called Font that contains 
commands for formatting text characters. 

 A command that appears in a different background color or has an 
outline is active. Many of these de-activate when you select the 
button again or select another choice.  

 A group could include a dialog box launcher which will open a dialog 
box containing additional tools and options for the Ribbon group. 

 Galleries will include a scroll bar with a more option that you can 
select to display the full list or gallery for that option. 

 Tabs appear only when they are applicable. For example, the Header 
& Footer Tools Ribbon tab appears only when you are working with 
headers and footers. 

Understand Ribbon Tabs 
 Several frequently used editing features, such as copy and paste, text 

formatting with bold, various fonts, alignment, a style etc. 
 Insert or add extra elements to the document, such as tables, icons, 

shapes, pages, symbols, etc. 
 Draw and erase using different colors and thicknesses with a pen 

tool or trackpad.  
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 Various formatting options for your document such as themes, 
effects, color schemes, paragraph spacing etc. 

 Modify the layout of the document, including the page orientation, 
margins, page breaks, spacing etc. 

 Enter document sources and citations, build a table of contents, add 
footnotes and endnotes, create an index, etc.  

 Merge emails, write, insert, and merge different fields, etc.  

 Check grammar, proofread, check accessibility, track changes, add or 
remove comments, etc. 

 Shift between different views of the document, change page 
movement, switch windows and has the feature of the Immersive 
Reader. 

 Contacting Microsoft Support, providing feedback to Microsoft, 
viewing training videos and learning about new tools. 

 Macros, installing add-ins, using content controls to build online 
forms, protecting against people making changes, or managing 
templates. You may need to display this Ribbon as it is hidden by 
default. 
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Unit 1: Unplugged Activities 
Instructor Guide 
 

Instructions 
Below are a variety of offline activities to choose from to support learning in the unit. Choose activities 
to enhance learning in the classroom.  

Activity 1: Word Search 
With Words - Use this word search to reinforce the key terms in the unit. An answer key is provided.  

With Clues - Use this word search to challenge learners to find key terms in the unit using clues. An 
answer key is provided. 

Activity 2: Crossword Puzzle 
Solve the crossword puzzle by reading clues and filling in the answer with key terms from the unit.  A 
solution key is provided. 

Activity 3: Multiple Choice Speed Game 
This game can be played as a class or small groups. This is a timed game where learners have 15 
seconds to choose the correct answer. Learners receive one point for each answer they get correct 
and total the amount at the end to see who has the most points.  Alternatively, you can have no points 
system. There are many options to adapt this game to your individual class. 

Activity 4: Label Diagram 
Print the Word image and have learners label the various features. This can be done as a class, small 
groups, pairs or individually. You can also make this a timed activity or a competition between teams 
for more interactive experience. An answer key is provided. 

Activity 5: Template Project 
Learners will have learned about the many Word Template options provided to users. Using this as 
inspiration for their project, learners will create a handmade template such as a recipe card, song, 
poem, invitation, newsletter etc. Encourage learners to think outside the box and not just copy a 
version from Word. Rubric included.  
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Unit 1: Unplugged Activity 
 

Activity 1: Word Search   

With Words - Use this word search to reinforce the key terms in the unit. An answer key is provided.  

With Clues – Use this word search to challenge learners to find key terms in the unit using clues. An 
answer key is provided. 
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Unit 1 Word Search with Words 
Complete the following word search by finding and circling all the words in the box below the puzzle. 
Words can be in any direction.  

 

ACCESSIBILITYCHECKER 
BACKSTAGE 
BAR 
BUILDINGBLOCKS 
COLLATED 
COMPATIBILITYCHECKER 
CONTEXTUAL 

DESIGN 
DIALOGBOX 
DRAFT 
EXTENSION 
FILEFORMATS 
FIND 
GRIDLINE 
 

INSERTIONPOINT 
INSPECTOR 
LANDSCAPE 
NAVIGATION 
PAGEORIENTATION 
PDF 
PORTRAIT 

QUICKACCESS 
REFERENCE 
RIBBON 
SAVEAS 
SCALING 
SCREENTIPS 
TELLME 

TEMPLATE 
VIEWOPTIONS 
ZOOM 
 

B U I L D I N G B L O C K S D B F F C G E
V I E W O P T I O N S F E I N L S L D E R
X C O M P A T I B I L I T Y C H E C K E R
I N S E R T I O N P O I N T H Y N S K H E
L L S B Q U I C K A C C E S S D Q C B P G
M C J M L L P L S B T H B F I A E A J A E
Y W B G F K D I A L O G B O X H L L Y G X
Y M F J Q I O U V Z A I T Z C X J I G E T
S W I F R R N K E I W G U Y K D I N U O E
C O L L A T E D A P O R T R A I T G R R N
R Q E T Y Z J J S R S I W M D J M O E I S
E B F E H O B K X F L D U H N L T X F E I
E A O M S O S Y R I A L N Z M C F E E N O
N C R P G M O R B V F I C E E N M P R T N
T K M L I T R I P D F N D P J L C G E A Y
I S A A W V S C O R L E S D L J U S N T R
P T T T F S H P E A J N H E N M K Z C I I
S A S E E W S I P F I X T S R A Q W E O B
G G P C V T S W I T N A V I G A T I O N B
X E C O N T E X T U A L R G S L L B A R O
L A N D S C A P E H U F Z N F T T W Y C N
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Unit 1 Word Search Solution Key 

 
  

B U I L D I N G B L O C K S D B F F C G E
V I E W O P T I O N S F E I N L S L D E R
X C O M P A T I B I L I T Y C H E C K E R
I N S E R T I O N P O I N T H Y N S K H E
L L S B Q U I C K A C C E S S D Q C B P G
M C J M L L P L S B T H B F I A E A J A E
Y W B G F K D I A L O G B O X H L L Y G X
Y M F J Q I O U V Z A I T Z C X J I G E T
S W I F R R N K E I W G U Y K D I N U O E
C O L L A T E D A P O R T R A I T G R R N
R Q E T Y Z J J S R S I W M D J M O E I S
E B F E H O B K X F L D U H N L T X F E I
E A O M S O S Y R I A L N Z M C F E E N O
N C R P G M O R B V F I C E E N M P R T N
T K M L I T R I P D F N D P J L C G E A Y
I S A A W V S C O R L E S D L J U S N T R
P T T T F S H P E A J N H E N M K Z C I I
S A S E E W S I P F I X T S R A Q W E O B
G G P C V T S W I T N A V I G A T I O N B
X E C O N T E X T U A L R G S L L B A R O
L A N D S C A P E H U F Z N F T T W Y C N
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Unit 1 Word Search with Clues 
Complete the following word search by finding and circling the words that fit the clues below. Words 
can be in any direction.  

 

  

B U I L D I N G B L O C K S D B F F C G E
V I E W O P T I O N S F E I N L S L D E R
X C O M P A T I B I L I T Y C H E C K E R
I N S E R T I O N P O I N T H Y N S K H E
L L S B Q U I C K A C C E S S D Q C B P G
M C J M L L P L S B T H B F I A E A J A E
Y W B G F K D I A L O G B O X H L L Y G X
Y M F J Q I O U V Z A I T Z C X J I G E T
S W I F R R N K E I W G U Y K D I N U O E
C O L L A T E D A P O R T R A I T G R R N
R Q E T Y Z J J S R S I W M D J M O E I S
E B F E H O B K X F L D U H N L T X F E I
E A O M S O S Y R I A L N Z M C F E E N O
N C R P G M O R B V F I C E E N M P R T N
T K M L I T R I P D F N D P J L C G E A Y
I S A A W V S C O R L E S D L J U S N T R
P T T T F S H P E A J N H E N M K Z C I I
S A S E E W S I P F I X T S R A Q W E O B
G G P C V T S W I T N A V I G A T I O N B
X E C O N T E X T U A L R G S L L B A R O
L A N D S C A P E H U F Z N F T T W Y C N
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Unit 1 Word Search Clues  

 CLUE 
 A collection of tabs located directly below the title bar, which provides quick 

access to commands required to complete a task. 
 A feature in which a small pop-up window appears when a mouse pointer 

hovers over an icon or button.  
 A feature that enables you to enlarge or decrease your view of the document. 
 A feature that enables you to locate specified text within a document. 
 A feature that is helpful to align items on the page such as images or shapes.  
 A feature that specifies how multiple copies of the document will be printed.  
 A feature you can use to check a document for items you may not want others to 

view if you share the document, such as personal information. 
 A feature you can use to ensure that a document can be accessed globally on 

various devices for users with accessibility issues, such as visual or audio 
impairment. 

 A feature you can use to ensure that a document can be opened in older 
versions of Word or in a different format that may be required for another 
program. 

 A file format used to maintain the design layout and format of a file for 
distribution to others, restrict the editing of file contents, or to make a file smaller 
so it can be set up as a link on a website for downloading. 

 A hidden tab or menu that appears when objects, such as text, images, or other 
elements are selected. 

 An option where you can enter keywords about a particular type of task and view 
information on how to complete that task. 

 Appropriate for most typing, editing, and formatting tasks. 
 Different ways of being able to observe the document to assist in working with 

the text, page layout, web layout, an outline, or reading. 
 May be up to four characters and describes the type of file (.docx for Word 

documents). 
 Pre-designed and customized blocks of text or elements inserted into a 

document such as text, logos, tables, or images. 
 Pre-designed document that can be used to create a specific type of document.  
 Select how many pages of the document will print on a sheet of paper. 
 The button at the lower right of a Ribbon group that displays a box or pane with 

more options for specific features. 
 The command used to save an existing document with a new name or to a 

different location. 
 The direction of the paper for text flow.  
 The flashing bar on the screen that indicates your current position in the 

document.  
 The page orientation that uses the length of the paper horizontally. 
 The page orientation that uses the length of the paper vertically. 
 The standard way that information is encoded in an electronic file and is 

indicated by the file name extension. 
 The view that appears when you select the File tab. 
 This tab draws a vertical line in each line of text at the tab stop. 
 This tab enables the user to enter document sources and citations, create a table 

of contents, add an index, etc. 
 This tab enables the user to format themes, backgrounds, color schemes, page 

borders, etc. 
 This toolbar contains popular commands such as Save, Undo, and Redo.  
 When active, a pane appears on the screen to help you search for text and 

displays the results by headings, pages, or a list of the results in the document. 
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Word Search with Clues Answer Key 
ANSWER KEY CLUE 
RIBBON A collection of tabs located directly below the title bar, which provides quick access to 

commands required to complete a task. 
SCREENTIPS A feature in which a small pop-up window appears when a mouse pointer hovers 

over an icon or button.  
ZOOM A feature that enables you to enlarge or decrease your view of the document. 
FIND A feature that enables you to locate specified text within a document. 
GRIDLINE A feature that is helpful to align items on the page such as images or shapes.  
COLLATED A feature that specifies how multiple copies of the document will be printed.  
INSPECTOR A feature you can use to check a document for items you may not want others to 

view if you share the document, such as personal information. 
ACCESSIBILITY 
CHECKER 

A feature you can use to ensure that a document can be accessed globally on various 
devices for users with accessibility issues, such as visual or audio impairment. 

COMPATIBILITY 
CHECKER 

A feature you can use to ensure that a document can be opened in older versions of 
Word or in a different format that may be required for another program. 

PDF A file format used to maintain the design layout and format of a file for distribution to 
others, restrict the editing of file contents, or to make a file smaller so it can be set up 
as a link on a website for downloading. 

CONTEXTUAL A hidden tab or menu that appears when objects, such as text, images, or other 
elements are selected. 

TELLME An option where you can enter keywords about a particular type of task and view 
information on how to complete that task. 

DRAFT Appropriate for most typing, editing, and formatting tasks. 
VIEW OPTIONS Different ways of being able to observe the document to assist in working with the 

text, page layout, web layout, an outline, or reading. 
EXTENSION May be up to four characters and describes the type of file (.docx for Word 

documents). 
BUILDING 
BLOCKS 

Pre-designed and customized blocks of text or elements inserted into a document 
such as text, logos, tables, or images. 

TEMPLATE Pre-designed document that can be used to create a specific type of document.  
SCALING Select how many pages of the document will print on a sheet of paper. 
DIALOGBOX The button at the lower right of a Ribbon group that displays a box or pane with more 

options for specific features. 
SAVEAS The command used to save an existing document with a new name or to a different 

location. 
PAGE 
ORIENTATION 

The direction of the paper for text flow.  

INSERTION 
POINT 

The flashing bar on the screen that indicates your current position in the document.  

LANDSCAPE The page orientation that uses the length of the paper horizontally. 
PORTRAIT The page orientation that uses the length of the paper vertically. 
FILE 
FORMATS 

The standard way that information is encoded in an electronic file and is indicated by 
the file name extension. 

BACKSTAGE The view that appears when you select the File tab. 
BAR This tab draws a vertical line in each line of text at the tab stop. 
REFERENCE This tab enables the user to enter document sources and citations, create a table of 

contents, add an index, etc. 
DESIGN This tab enables the user to format themes, backgrounds, color schemes, page 

borders, etc. 
QUICK 
ACCESS  

This toolbar contains popular commands such as Save, Undo, and Redo.  

NAVIGATION  When active, a pane appears on the screen to help you search for text and displays 
the results by headings, pages, or a list of the results in the document. 
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Unit 1: Unplugged Activity  
 

Activity 2: Crossword Puzzle 
Solve the crossword puzzle by reading clues and filling in the answer with key terms from the unit.  An answer 
key is provided. 
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Unit 1 Crossword Puzzle 
 
Use the clues to solve the crossword puzzle. 
 

 
 
 
 

1 2

3 4

5 6 7

8 9

10 11

12 13

14 15

16

17

18 19

20

21

22

23 24

25

26

27

28
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Unit 1 Crossword Clues 
 
Across 
 1 This tab enables the user to enter document sources and citations, create a table of contents, add an index, etc. (9) 
 3 Pre-designed document that can be used to create a specific type of document. (8) 
 5 A feature that specifies how multiple copies of the document will be printed. (8) 
 7 This tab enables the user to format themes, backgrounds, color schemes, page borders, etc. in a document. (6) 
 8 A collection of tabs located directly below the title bar, which provides quick access to commands required to 

complete a task. (6) 
 10 The page orientation that uses the length of the paper vertically. (8) 
 12 A feature that enables you to locate specified text within a document. (4) 
 14 A checking feature you can use to ensure a document can be accessed globally on various devices for users with 

visual or audio impairment. (13) 
 16 A feature that is helpful to align items on the page such as images or shapes. (8) 
 18 The flashing bar on the screen that indicates your current position in the document. (14) 
 21 The direction of the paper for text flow. (15) 
 22 Select how many pages of the document will print on a sheet of paper. (7) 
 23 When active, a pane appears on the screen to help you search for text and displays the results by headings, pages, 

or a list of the results in the document. (10) 
 25 The view that appears when you select the File tab. (9) 
 26 The command used to save an existing document with a new name or to a different location. (6) 
 27 A feature that enables you to enlarge or decrease your view of the document. (4) 
 28 A hidden tab or menu that appears when objects, such as text, images, or other elements are selected. (10) 
 
Down 
 2 The standard way that information is encoded in an electronic file and is indicated by the file name extension. (11) 
 4 May be up to four characters and usually describes the type of file (for example, .docx for Word documents). (9) 
 6 Appropriate for most typing, editing, and formatting tasks. (5) 
 7 The button at the lower right of a Ribbon group that displays a box or pane with more options for specific 

features. (9) 
 9 Pre-designed and customized blocks of text or elements inserted into a document such as text, logos, tables, or 

images. (8) 
 10 A file format used to maintain the design layout and format of a file for distribution to others, restrict the editing of 

file contents, or to make a file smaller so it can be set up as a link on a website for downloading. (3) 
 11 A feature you can use to check a document for items you may not want others to view if you share the document, 

such as personal information. (9) 
 13 Different ways of being able to observe the document to assist in working with the text, page layout, web layout, 

an outline, or reading. (11) 
 15 A checking feature you can use to ensure a document can be opened in older versions of Word or in a different 

format that may be required for another program. (13) 
 17 This toolbar contains popular commands such as Save, Undo, and Redo. (11) 
 19 A feature in which a small pop-up window appears when a mouse pointer hovers over an icon or button. (10) 
 20 The page orientation that uses the length of the paper horizontally. (9) 
 24 An option where you can enter keywords about a particular type of task and view information on how to complete 

that task. (6) 
 25 This tab draws a vertical line in each line of text at the tab stop. (3) 
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Unit 1 Crossword Puzzle Answer Key 
 

 
 
 
 

R
1

E F
2

E R E N C E

T
3

E M P L A T E
4

I

X C
5

O L L A T E D
6

D
7
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T E R I

E F A A

R
8

I B
9

B O N O F L

U S P
10

O R T R A I
11

T O

I F
12
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13

L O F A
14

C C
15

E S S I B I L I T Y

G
16

R I D L I N E T O P O E
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N Q
17

P C O

G U A T P

I
18

N S
19

E R T I O N P O I N T

C C I R I

L
20

K R B O

A P
21

A G E O R I E N T A T I O N

S
22

C A L I N G C E L S

D C N
23

A V I G A T
24

I O N

B
25

A C K S T A G E T T E

A C S I Y L
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26
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P S Z
27

O O M

C
28

O N T E X T U A L E
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Unit 1: Unplugged Activity 
 

Activity 3: Multiple Choice Speed Game 
This game can be played as a class or small groups. This is a timed game where learners have 15 
seconds to choose the correct answer. Learners receive one point for each answer they get correct. 
Total the amount at the end of the game to see who has the most points.  Alternatively, you can have 
a no points system. There are many options to adapt this game to your individual class. A timing device 
will be needed. 

 

Instructor Led Option 

• Display one at a time the definitions/questions and multiple-choice answers to the class using a 
smartboard or projector. 

• Learners can answer the multiple-choice answer (A, B, C, D), by writing on a personal dry erase 
board, calling out the answer or any other method of your choice. 

• Reveal the correct answer after 15 seconds.  

 

Learner Led Option  

• Print off definitions/questions and multiple-choice answers. Fold in half if you prefer. 

• Place learners into small groups, assign one learner to be the game host and read the definitions 
and answers. 

• The remaining learners play the game.  

• Learners can answer the multiple-choice answer (A, B, C, D), by writing on a personal dry erase 
board, calling out the answer or any other method of your choice. 

• The game host reveals the correct answer after 15 seconds.  
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Unit 1 Multiple Choice Speed Game  
Multiple Choice Definition/Question 

A) Accessibility Checker 
B) Compatibility Checker 
C) Compatible Checker 
D) Accessible Checker 

A feature you can use to ensure that a 
document can be accessed globally on 
various devices for users with 
accessibility issues, such as visual or 
audio impairment. 

A) Portrait 
B) Backstage 
C) Landscape 
D) Frontstage 

The view that appears when you select 
the File tab. It provides commands that 
deal with the entire file. 

A) Design 
B) Custom 
C) Building  
D) Text 

Pre-designed and customized blocks of 
text or elements inserted into a 
document such as text, logos, tables, or 
images. 

A) Compatibility Checker 
B) Accessibility Checker 
C) Format Checker 
D) Document Checker 

A feature you can use to ensure that a 
document can be opened in older 
versions of Word or in a different format 
that may be required for another 
program. 

A) Menu Tabs 
B) Contextual Tabs 
C) Image Tabs 
D) Document Tabs 

A hidden tab or menu that appears when 
objects, such as text, images, or other 
elements are selected.  

A) Toolbar Launcher 
B) Pane Button 
C) Dialog Box Launcher 
D) References Button 

The button at the lower right of a Ribbon 
group that displays a box or pane with 
more options for specific features. 

A) Document Properties 
B) Privacy Properties 
C) Privacy Inspector 

A feature you can use to check a 
document for items you may not want 
others to view if you share the document, 
such as personal information. 
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D) Document Inspector

A) .xlxs
B) .rtf
C) .docx
D) .pub

Which of the following is not a file 
extension used for Word documents? 

A) Portable Document Format
B) File Format
C) Plain Text Format
D) Word Format

The standard way that information is 
encoded in an electronic file and is 
indicated by the file name extension. 

A) Help
B) Home
C) Find
D) View

A feature that enables you to find 
specified text within a document. 

A) Search
B) Display
C) Review
D) Navigation

When active, a pane appears on the 
screen to help you search for text and 
displays the results by headings, pages, 
or a list of the results in the document. 

A) Page Orientation
B) Portrait Orientation
C) Landscape Orientation
D) Collated Orientation

The direction of the paper for text flow. 

A) .pub
B) .pdf
C) .txt
D) .rtf

A file format used to maintain the design 
layout and format of a file for distribution 
to others, restrict the editing of file 
contents, or to make a file smaller so it 
can be set up as a link on a website for 
downloading. 

A) Ribbon
B) Title
C) Quick Access
D) Status

This toolbar contains popular commands 
such as Save, Undo, and Redo and can be 
customized for those commands you use 
frequently. 
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A) Developer 
B) Layout 
C) Reference 
D) Ribbon 

A collection of tabs located directly below 
the title bar, which provides quick access 
to commands required to complete a 
task. 

A) Design 
B) Draw 
C) Layout 
D) Review 

This tab enables the user to format 
themes, backgrounds, color schemes, 
page borders, etc. in a document.  

 

A) Developer 
B) References 
C) Layout 
D) Review 

This tab enables the user to enter 
document sources and citations, create a 
table of contents, add an index, etc. 

A) What’s New 
B) Search 
C) Tell Me 
D) Toolbar 

An option where you can enter keywords 
about a particular type of task and view 
information on how to complete that 
task. 

 

A) Store 
B) Save 
C) Save As 
D) Store 

The command used to save an existing 
document with a new name or to a 
different location. 

A) Template 
B) Icon 
C) Gridline 
D) ScreenTip 

A feature in which a small pop-up 
window appears when a mouse pointer 
hovers over an icon or button.  

A) Document 
B) Template 
C) Table 
D) Title Bar 

Pre-designed document that can be 
used to create a specific type of 
document.  
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A) Review 
B) View 
C) Layout 
D) References 

This tab enables users to proofread, add 
or remove comments, track changes, 
Read Aloud, check accessibility, etc. 

 

A) Zoom 
B) Maximize 
C) Minimize 
D) Slider 

A feature that enables you to enlarge or 
decrease your view of the document. 

A) Outline 
B) Draft 
C) Print Layout 
D) Read Mode 

Appropriate for most typing, editing, and 
formatting tasks. 

A) Center 
B) Bar 
C) Decimal 
D) Left 

This tab draws a vertical line in each line 
of text at the tab stop. 

A) Print 
B) Collated 
C) Scaling 
D) Page Setup 

This feature determines how many 
pages of the document will print on a 
sheet of paper. 
 

A) Gridline 
B) Navigation 
C) Ruler 
D) Toolbar 

This feature is helpful when you want to 
align items on the page such as images 
or shapes.  

A) CTRL+DOWN 
B) CTRL+PGDN  
C) CTRL+END 
D) CTRL+RIGHT 

The keyboard shortcut to move to the 
next page in a document. 

A) Print 
B) Collated 

This feature specifies how multiple 
copies of the document will be printed. 
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C) Scaling 
D) Page Setup 
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Multiple Choice Speed Game Answer Key 
Multiple Choice Definition/Question 

A) Accessibility Checker 
B) Compatibility Checker 
C) Compatible Checker 
D) Accessible Checker 

A feature you can use to ensure that a 
document can be accessed globally on 
various devices for users with 
accessibility issues, such as visual or 
audio impairment. 

A) Portrait 
B) Backstage 
C) Landscape 
D) Frontstage 

The view that appears when you select 
the File tab. It provides commands that 
deal with the entire file. 

A) Design 
B) Custom 
C) Building  
D) Text 

Pre-designed and customized blocks of 
text or elements inserted into a 
document such as text, logos, tables, or 
images. 

A) Compatibility Checker 
B) Accessibility Checker 
C) Format Checker 
D) Document Checker 

A feature you can use to ensure that a 
document can be opened in older 
versions of Word or in a different format 
that may be required for another 
program. 

A) Menu Tabs 
B) Contextual Tabs 
C) Image Tabs 
D) Document Tabs 

A hidden tab or menu that appears when 
objects, such as text, images, or other 
elements are selected.  

A) Toolbar Launcher 
B) Pane Button 
C) Dialog Box Launcher 
D) References Button 

The button at the lower right of a Ribbon 
group that displays a box or pane with 
more options for specific features. 

A) Document Properties 
B) Privacy Properties 
C) Privacy Inspector 

A feature you can use to check a 
document for items you may not want 
others to view if you share the document, 
such as personal information. 
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D) Document Inspector 

A) .xlxs 
B) .rtf 
C) .docx 
D) .pub 

Which of the following is not a file 
extension used for Word documents? 

A) Portable Document Format 
B) File Format 
C) Plain Text Format 
D) Word Format 

The standard way that information is 
encoded in an electronic file and is 
indicated by the file name extension. 

A) Help 
B) Home 
C) Find  
D) View 

A feature that enables you to find 
specified text within a document. 

A) Search 
B) Display 
C) Review 
D) Navigation 

When active, a pane appears on the 
screen to help you search for text and 
displays the results by headings, pages, 
or a list of the results in the document. 

A) Page Orientation 
B) Portrait Orientation 
C) Landscape Orientation 
D) Collated Orientation 

The direction of the paper for text flow.  

A) .pub 
B) .pdf 
C) .txt 
D) .rtf 

A file format used to maintain the design 
layout and format of a file for distribution 
to others, restrict the editing of file 
contents, or to make a file smaller so it 
can be set up as a link on a website for 
downloading. 

A) Ribbon  
B) Title  
C) Quick Access 
D) Status 

This toolbar contains popular commands 
such as Save, Undo, and Redo and can be 
customized for those commands you use 
frequently. 
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A) Developer 
B) Layout 
C) Reference 
D) Ribbon 

A collection of tabs located directly below 
the title bar, which provides quick access 
to commands required to complete a 
task. 

A) Design 
B) Draw 
C) Layout 
D) Review 

This tab enables the user to format 
themes, backgrounds, color schemes, 
page borders, etc. in a document.  

 

A) Developer 
B) References 
C) Layout 
D) Review 

This tab enables the user to enter 
document sources and citations, create a 
table of contents, add an index, etc. 

A) What’s New 
B) Search 
C) Tell Me 
D) Toolbar 

An option where you can enter keywords 
about a particular type of task and view 
information on how to complete that 
task. 

 

A) Store 
B) Save 
C) Save As 
D) Store 

The command used to save an existing 
document with a new name or to a 
different location. 

A) Template 
B) Icon 
C) Gridline 
D) ScreenTip 

A feature in which a small pop-up 
window appears when a mouse pointer 
hovers over an icon or button.  

A) Document 
B) Template 
C) Table 
D) Title Bar 

Pre-designed document that can be 
used to create a specific type of 
document.  
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A) Review 
B) View 
C) Layout 
D) References 

This tab enables users to proofread, add 
or remove comments, track changes, 
Read Aloud, check accessibility, etc. 

 

A) Zoom 
B) Maximize 
C) Minimize 
D) Slider 

A feature that enables you to enlarge or 
decrease your view of the document. 

A) Outline 
B) Draft 
C) Print Layout 
D) Read Mode 

Appropriate for most typing, editing, and 
formatting tasks. 

A) Center 
B) Bar 
C) Decimal 
D) Left 

This tab draws a vertical line in each line 
of text at the tab stop. 

A) Print 
B) Collated 
C) Scaling 
D) Page Setup 

This feature determines how many 
pages of the document will print on a 
sheet of paper. 
 

A) Gridline 
B) Navigation 
C) Ruler 
D) Toolbar 

This feature is helpful when you want to 
align items on the page such as images 
or shapes.  

A) CTRL+DOWN 
B) CTRL+PGDN  
C) CTRL+END 
D) CTRL+RIGHT 

The keyboard shortcut to move to the 
next page in a document. 

A) Print 
B) Collated 

This feature specifies how multiple 
copies of the document will be printed. 
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C) Scaling 
D) Page Setup 
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Unit 1: Unplugged Activity 
 

Activity 4: Label Diagram  
Print the Word image and have learners label the various features. This can be done as a class, small 
groups, pairs or individually. You can also make this a timed activity or a competition between teams 
for a more interactive experience. An answer key is provided.  

 

Use the following cards to label the diagram. You can print, cut and label the diagram.  

File Tab 

↓ 

Minimize/Maximize/ 
Restore Down/Close 

↓ 

Quick Access 
Toolbar 

↓ 

Insertion Point 

↓ 

Ribbon Tabs 

↓ 

Status Bar 

↓ 

Title Bar 

↓ 

View Buttons 

↓ 

Tell Me 

↓ 

Zoom Slider 

↓ 

 Zoom Level 

↓ 
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Unit 1 Label Diagram Answer Key 

  

 

Status Bar 
Zoom Zoom 
Slider Level 

View 
Buttons 

File Tab Quick Access Toolbar Ribbon Tabs Title Bar Tell Me Min/Restore/Max/Close 

Insertion Point 
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Unit 1: Unplugged Activity  
 

Activity 5: Template Project 
Learners will have learned about the many Word Template options provided to users. Using this as 
inspiration for their project, learners will create a handmade “template” such as a recipe card, song, 
poem, invitation, newsletter etc. Encourage learners to think outside the box, be unique and not just 
copy a version from Word. This is a one-page submission. Learners should show their learning of Word 
by using different colors, fonts, images etc. for their project.  

If you choose to grade this activity, the following rubric can be used as guide.  

Criteria Excellent 

 

Good 

 

Satisfactory 

 

Needs 
Improvement 

 4 3 2 1 

Creativity Design is unique, 
detailed, and 
interesting. 

Design is 
generally unique, 
detailed, and 
interesting. 

Design is 
somewhat unique, 
detailed, and 
interesting. 

Design lacks 
being unique, 
detailed, or 
interesting. 

Use of Word 
Template 
Features 

Excellent 
understanding 
and use of Word 
Template features.  

Good 
understanding 
and use of Word 
Template features. 

Satisfactory 
understanding 
and use of Word 
Template features. 

Minimal 
understanding 
and use of Word 
Template features. 

Understanding 
of Project 

Excellent 
understanding of 
project 
requirements. 
Activity followed 
and work well 
completed.  

Good 
understanding of 
project 
requirements. 
Activity followed 
and work mostly 
completed. 

Satisfactory 
understanding of 
project 
requirements. 
Activity followed 
and work 
somewhat 
completed. 

Lack of 
understanding of 
project 
requirements. 
Activity not 
followed or 
completed. 

Effort & 
Production 

Work shows 
excellent effort, 
planning. Used 
class time to the 
maximum.  

Work shows good 
effort and 
planning. Used 
class time for 
work but was 
sometimes off 
task. 

Work shows 
satisfactory effort 
and planning. 
Class time not 
used as efficiently 
as it could be.  

Work shows 
minimal effort and 
planning. Class 
time not used 
effectively. 
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Word Unit 1 Key Terms 
Term Definition 

.docx The file type associated with Microsoft Word 2007 and later and is 
automatically assigned to the end of a file name. 

Accessibility 
Checker 

A feature you can use to ensure that a document can be accessed globally on 
various devices for users with accessibility issues, such as visual or audio 
impairment. 

Backstage The view that appears when you select the File tab. It provides commands 
that deal with the entire file. 

Compatibility 
Checker 

A feature you can use to ensure that a document can be opened in older 
versions of Word or in a different format that may be required for another 
program. 

Contextual Tabs A hidden tab or menu that appears when objects, such as text, images, or 
other elements are selected.  

Dialog Box 
Launcher 

The button at the lower right of a Ribbon group that displays a dialog box or 
pane with more options for specific features. 

Document 
Inspector 

A feature you can use to check a document for items you may not want others 
to view if you share the document, such as personal information. 

File Formats The standard way that information is encoded in an electronic file. The file 
format is indicated by the file name extension. 

Go To Feature  A quick method of jumping to a specific page.   

Gridlines A feature to help align items on a page such as images and shapes.   

Navigation Pane When active, a pane appears on the screen to help you search for text and 
displays the results by headings, pages, or a list of the results in the document. 

Page Orientation The direction of the paper for text flow. Portrait uses the length of the paper 
vertically. Landscape uses the length of the paper horizontally. 

PDF A file format used to maintain the design layout and format of a file for 
distribution to others, restrict the editing of file contents, or to make a file 
smaller so it can be set up as a link on a website for downloading. 

Quick Access 
Toolbar 

Contains popular commands such as Save, Undo, and Redo. This toolbar can 
be customized for those commands you use frequently. 

Ribbon A collection of tabs located directly below the title bar, which provides quick 
access to commands required to complete a task. 

Ribbon Groups The groupings on each ribbon tab containing commands for specific tasks. 

Ribbon Tabs A collection of command buttons organized into logical groups that relate to 
a type of activity. 

Save The command used to store a document. 

Save As The command used to save an existing document with a new name or to a 
different location. 

ScreenTip A feature in which a small pop-up window appears when a mouse pointer 
hovers over an icon or button. The pop-up window will provide details that 
explain the icon’s or button’s function. 
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Template Pre-designed document that can be used to create a specific type of 
document. Setting up a template enables documents to have a consistent 
look. 

View Options Different ways of being able to view the document, usually to assist in working 
with the text, page layout, web layout, an outline, or reading. 

Zoom A feature that enables you to enlarge or decrease your view of the document. 
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Word Course Key Terms 
Term Definition 

.docx The file type associated with Microsoft Word 2007 and later and is 
automatically assigned to the end of a file name. 

3D Models Insert a 3D Model object from an online source to add a multidimensional 
element; you can modify its appearance and position in the document. 

Accessibility 
Checker 

A feature you can use to ensure that a document can be accessed globally on 
various devices for users with accessibility issues, such as visual or audio 
impairment. 

Alternative Text Commonly referred to as Alt Text, this is descriptive text added to graphic 
objects which can be read aloud by screen readers or other text-to-speech 
tools. 

Artistic Effect Apply an effect that gives the picture an artistic appearance such as looking 
at a picture with a block glass effect. 

AutoCorrect Automatic corrections for spelling errors, incorrect capitalization, and some 
identified shortcuts. Word automatically corrects small typos or mistakes as 
text is being entered.  

Backstage The view that appears when you select the File tab. It provides commands 
that deal with the entire file. 

Bookmark  Assigns a name to the item or location in the document. 

Bulleted List A designated list that uses symbols such as bullets to indicate there is no 
priority set for the list items. The bullet character can be customized, as 
required. 

Character 
Formatting 

The special stylized variations applied to plain characters to make them stand 
out from other text. They include bold, italics, underline, and color. 

Charts A type of diagram that can display trends or patterns in a series of data. 

Clipboard A feature to temporarily store any cut or copied items such as text or graphics. 

Color Options Adjust the intensity or saturation of the color in the image. 

Columns A feature to format document text into “newspaper style”. 

Combine 
Documents  

Combine revisions from multiple authors into a single document. To combine 
multiple documents, combine two documents together first and then 
combine another document with the new merged document. 

Comments Appear in the Markup area at the right of the document and are used to 
provide specific instructions, describe decisions that were made, seek 
clarification, ask a question or specify any content that needs to be revised or 
reformatted.  

Compare 
Documents 

Compares two versions of a document and displays only what changed 
between them. This helps to quickly identify the differences. The documents 
that are being compared are not changed.  

Compatibility 
Checker 

A feature you can use to ensure that a document can be opened in older 
versions of Word or in a different format that may be required for another 
program. 
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Compress 
Pictures 

Reduce the size of the picture by changing its resolution or clarity. 

Contextual Tabs A hidden tab or menu that appears when objects, such as text, images, or 
other elements are selected.  

Convert a Table Convert a table to a tabbed report. 

Convert Text to a 
Table 

Convert selected text to a table format. 

Copy An editing function used to duplicate designated text, objects or files using 
the Clipboard. 

Correction 
Options 

Change or correct the brightness or contrast of a picture and sharpen or 
soften the picture to adjust its clarity. 

Cover Page Introduces the document with a proper title, a potential image, and provides 
a brief overview of the information that will be in the document. 

Crop Objects Cut or remove portions of an object, either from the horizontal, vertical, or fit 
to a shape. 

Cross-Reference Links to other parts of the same document. For example, a cross-reference is 
created to link to a chart or graphic that appears elsewhere in the document. 
The cross-reference appears as a link that takes the reader to the referenced 
item.  

Cut An editing function used to move designated text, objects, or files to the 
Clipboard. 

Dialog Box 
Launcher 

The button at the lower right of a Ribbon group that displays a dialog box or 
pane with more options for specific features. 

Document 
Inspector 

A feature you can use to check a document for items you may not want others 
to view if you share the document, such as personal information. 

Drawing Canvas An enclosed area that keeps shapes together within that space.  

Effects Stylizations you can add to text. Strikethrough, superscript/subscript, shadow, 
and small caps are examples of text effects. 

Endnotes Commonly used to reference a selected item in the document, and generally 
include information about the author or originator of the item. Endnotes 
appear at the end of the document or document section. 

File Formats The standard way that information is encoded in an electronic file. The file 
format is indicated by the file name extension. 

Font Describes the typeface or appearance of characters. 

Font Styles The typeface variation including normal, bold, italic, bold italic. 

Footers Text or graphics that appear at the bottom of a page. Usually contain simple 
information such as the document title, page number, or author’s name; or it 
can contain sophisticated graphics (such as a company logo or product 
design). 

Footnotes Commonly used to reference a selected item in the document, and generally 
include information about the author or originator of the item. Footnotes 
usually appear at the bottom of the page but may also be placed directly 
below the text. Each footnote has a numbered note reference mark, which 
usually restarts on each page.  
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Format Painter The feature that enables you to copy or paint formatting attributes from one 
selection of text to another selection or selections of text. 

Formulas A calculation set up in a table using basic mathematical operands. 

Go To Feature  A quick method of jumping to a specific page.   

Gridlines A feature to help align items on a page such as images and shapes.   

Group Objects Group multiple objects together so the object is treated as one object. Any 
effects applied to the group affect everything in that group. 

Gutter The amount of white space added to the top or side margin if the document 
is to be bound. 

Header Rows The first row of a table that repeats at the top of the table on every page where 
data for the table displays. 

Headers Text or graphics that appear at the top of a page. Usually contain simple 
information such as the document title, page number, or author’s name; or it 
can contain sophisticated graphics (such as a company logo or product 
design). 

Icons Scalable vector graphics that visually represent ideas, objects, or actions. 

Insert Online 
Pictures 

Insert a picture from an online location using the Bing search engine which 
includes pictures designed for use as Creative Commons. 

Insert Picture 
from File 

Insert a picture from a location you can access on your computer, such as the 
local drive, a USB drive, or a network/cloud drive. 

Layer Objects Arrange objects to create a layer effect. 

Leader A Tab option gives the audience a visual guide when reading across the page. 

Line Spacing The amount of white space between lines of entered text, measured from the 
baseline of one line of text to the baseline of the next line of text. 

Links Give readers instant access to information on a Web Page, in another part of 
the same document, to an existing document, a new document or to an E-
mail Address. The hyperlink can be text or graphics.  

List Style Styles that are set up to be applied to list items that include indent positions 
for the list items. These styles can be customized. 

Margin The amount of space between the edge of the paper and the printed text area. 

Mini Toolbar A small toolbar that appears and contains the most used features from the 
Font and Paragraph groups.  

Multilevel List A designated list that displays various levels of items using bullets, numbers, 
or a combination. 

Navigation Pane When active, a pane appears on the screen to help you search for text and 
displays the results by headings, pages, or a list of the results in the document. 

Numbered List A designated list that uses numbers to indicate a priority for items. This type 
of list can be customized to use roman numerals or alpha characters instead 
of numbers. 

Orientation The printed text layout. 

Page Break Ends the page wherever you want by inserting the break. 

Page Numbers Keep track of the number of pages in a document and are inserted into a 
header or footer.  

73



Page Orientation The direction of the paper for text flow. Portrait uses the length of the paper 
vertically. Landscape uses the length of the paper horizontally. 

Paste The editing function of placing cut or copied data into a new location. 

PDF A file format used to maintain the design layout and format of a file for 
distribution to others, restrict the editing of file contents, or to make a file 
smaller so it can be set up as a link on a website for downloading. 

Picture Effects Apply effects to the picture such as a glow or shadow. 

Picture Styles Pre-designed effects that can create a specific mood for the document 
message. 

Position Objects Drag the object to another location in the document or set precise 
measurements for where the object should appear in the document. 

Proofing Pane Displays detected errors in the context of the sentence in which it appears. 
The type of error (spelling or grammar) is listed at the top of the pane, and a 
brief description of why the detected instance was flagged as an error also 
appears. 

Quick Access 
Toolbar 

Contains popular commands such as Save, Undo, and Redo. This toolbar can 
be customized for those commands you use frequently. 

Redo A feature that allows you to redo an action. 

Resize Objects Drag one of the handles around the object to resize the object; or enter 
specific measurements for a precise size for the object. 

Reviewing Pane Used to view all the tracked changes in one location, enabling editors to scroll 
through the pane to review changes or to get an idea of how many changes 
were made to the document.  

Ribbon A collection of tabs located directly below the title bar, which provides quick 
access to commands required to complete a task. 

Ribbon Groups The groupings on each ribbon tab containing commands for specific tasks. 

Ribbon Tabs A collection of command buttons organized into logical groups that relate to 
a type of activity. 

Rotate Objects Rotate the object by a specific angle or drag the rotation handle to an angle 
of your choice. 

Rows A horizontal bar that includes information related to the items in the table. 

Save The command used to store a document. 

Save As The command used to save an existing document with a new name or to a 
different location. 

Screen Clipping Take a capture of a selected portion of the open application window. 

Screenshot Take a capture of the entire open application window.  

ScreenTip A feature in which a small pop-up window appears when a mouse pointer 
hovers over an icon or button. The pop-up window will provide details that 
explain the icon’s or button’s function. 

Section Break Separates a document into sections to which specific formatting can be 
applied. 

Select A feature that enables you to highlight data for a future action such as 
deleting, copying, formatting, converting to a table, etc. 

Shapes Draw a variety of shapes that can be modified with fills, colors, or effects. 
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SmartArt Create and modify specific types of diagrams such as organization charts, a 
matrix, or list processes. 

SmartArt Text 
Pane 

Activate this pane in the SmartArt diagram to edit text.  

Sort Data Sort data in alphabetical or numerical order. 

Spelling and 
Grammar 

The spelling portion of the feature checks for incorrect spelling, duplicate 
words, and incorrect capitalization. The grammar portion of the feature 
detects sentences with grammatical errors or weak writing style, based on 
standards set in the options selected for checking spelling and grammar. 

Split Table Used to split a table at a specific location.  

Style A combination of character and paragraph formatting that you save with a 
unique style name. 

Symbols Characters that can be inserted into a document, either as a text character or 
for a bullet or numbering style. 

Tab Stops Used to align text at specific points in the document. 

Table of Contents A list of headings for all sections in a document, organized in the order in 
which the section appears in the document, complete with the 
corresponding page numbers and selected formatting. 

Table Styles Styles set up with formatting options for a table. 

Tables A grid that combines columns and rows for quick alignment and display of a 
large amount of data, such as a revenue report, stock price, inventory items, 
etc. 

Template Pre-designed document that can be used to create a specific type of 
document. Setting up a template enables documents to have a consistent 
look. 

Text Box Insert a pre-designed text box or draw a text box; used to enter text into 
directly and to emphasize specific areas of a document.   

Text Size The height of the characters. As characters get taller, they grow proportionally 
wider. 

Text Wrapping Choose various ways to have text wrap around the object in the document. 

Theme A set of unified design elements, such as colors, fonts, and graphics, which 
provides a consistent look for all pages in a document. 

Track Changes Allows editors to see what changes have been made to the document; 
insertions, deletions, text repositioning, and formatting changes will be 
recorded.  

Transparency Set one color in the picture to be transparent. 

Undo A feature to reverse an action (for example, deleting, formatting, adding text, 
or setting tabs). 

View Options Different ways of being able to view the document, usually to assist in working 
with the text, page layout, web layout, an outline, or reading. 

Watermarks Can be text, graphics, shapes, or pictures that appear behind text on every 
page of the document (unless otherwise formatted). 

WordArt Use this feature to create text with decorative effects. 

Zoom A feature that enables you to enlarge or decrease your view of the document. 
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